Chapter 1 • Introduction to SAS Lineage .......................................................... 1
What Is SAS Lineage? ......................................................................................... 1
Benefits of SAS Lineage .................................................................................... 2
Roles and Capabilities in SAS Lineage ............................................................... 3
Connecting SAS Lineage to Applications ......................................................... 5

Chapter 2 • Accessing SAS Lineage ................................................................. 7
Accessing SAS Lineage ....................................................................................... 7
Adding Links to the SAS Data Management Console Home Page ................. 11

Chapter 3 • Understanding the Interface ...................................................... 13
SAS Lineage Window ......................................................................................... 13
Preferences Window ......................................................................................... 20

Chapter 4 • Working with SAS Lineage ......................................................... 21
Selecting a Subject .......................................................................................... 21
Choosing a View .............................................................................................. 25
Using a Network Diagram ............................................................................... 31
Using an Impact Diagram .............................................................................. 33
Creating and Managing User-Defined Views ............................................... 35
Contents
Accessibility Features of SAS Lineage

Overview

SAS Lineage has not been tested for compliance with U.S. Section 508 standards and W3C web content accessibility guidelines. If you have specific questions about the accessibility of SAS products, send them to accessibility@sas.com or call SAS Technical Support.

Documentation Format

Please contact accessibility@sas.com if you need this document in an alternative digital format.
## Keyboard Shortcuts

The keyboard shortcuts listed in the following table are available for SAS Lineage:

**Keyboard Shortcuts for SAS Lineage**

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in</td>
<td>Ctrl+plus sign</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Ctrl+minus sign</td>
</tr>
<tr>
<td>Reset the zoom state</td>
<td>Ctrl+0</td>
</tr>
<tr>
<td>Invert or revert application colors</td>
<td>Ctrl+~</td>
</tr>
<tr>
<td>Open the Landmarks window</td>
<td>Ctrl+F6</td>
</tr>
<tr>
<td>Open the Keyboard Shortcuts window</td>
<td>F9</td>
</tr>
<tr>
<td>Move from object to object in the diagram</td>
<td>Arrow keys</td>
</tr>
</tbody>
</table>
Introduction to SAS Lineage

What Is SAS Lineage?

SAS Lineage is a web-based diagram component for visualizing relationships between objects. It is used as a stand-alone lineage and relationship viewer that can be accessed by SAS database management and business intelligence applications. The component has two modes:

- A network diagram displays all relationships.
- Two left-to-right dependency diagrams are available: one that displays data governance information (governance) and another that displays parent and child relationships only (impact analysis).
The relationship information displayed in these diagrams is drawn from the Relationship database that is a part of the Web Infrastructure Platform Data Server.

SAS Lineage can display most types of SAS metadata. This includes data objects, including columns, tables, external files, information maps, reports, stored processes, SAS Enterprise Guide projects and associated objects, and the levels and measures in OLAP cubes. You can also display objects created in SAS Business Data Network, such as terms, tags, and associated items.

**Benefits of SAS Lineage**

A number of important new features have been added to the lineage and impact analysis feature:

- SAS has created a shared store for all relationship information, called the SAS relationship service. Most SAS products and object types are now integrated into the SAS relationship service.

- There is also the ability to import content from third-party sources.

- The relationships web viewer has been enhanced to add a number of new views for displaying information stored in the service.

- There are also views for all Relationships and for Data Governance. These views are named All Relationships, Governance, and Impact Analysis.

You can also create your own views using the filtering capabilities of the viewer. This can help you subset the information to only the objects and relationships that you want to see. In addition, there are helpful features such as grouping node sets, which enable you to expand on demand, and an overview window with details of objects.
Roles and Capabilities in SAS Lineage

Overview

When you log on to SAS Lineage from SAS data management applications, you are granted access to applications and features based on the roles and capabilities that are associated with your login. Typically, these roles are assigned to a group to which you belong. For example, by default, members of the Data Management Business Users group have the Data Management: Lineage role. This role has one capability: ViewApplication, which enables access to SAS Lineage. Without this capability, you cannot access the SAS Lineage application.

Default Groups, Roles, and Capabilities

The following groups, roles, and capabilities are installed in SAS Management Console when SAS Lineage is installed.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role Description</th>
<th>Capability IDs</th>
<th>Groups That Get This Role by Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Management: Lineage</td>
<td>Provides default access to the SAS Lineage application.</td>
<td>ViewApplication</td>
<td>Data Management Stewards, Data Management Business Users, Data Management Business Approvers, Data Management Power Users, and Data Management Executives</td>
</tr>
<tr>
<td>Lineage: Administration</td>
<td>Provides all functionality related to administrative activities for the SAS Lineage application.</td>
<td>ViewApplication, UpdateRelationships</td>
<td>Data Management Administrators</td>
</tr>
</tbody>
</table>
The ViewApplication capability gives you default access to SAS Lineage. Without this capability, the SAS Lineage application link is not present for this user. The UpdateRelationships capability enables you to apply changes to the Relationship Service (for example, Import Relationships). This capability is intended to control access to the Import Relationships window and to the user interface’s facility for creating equivalent relationships. If the capability is not granted to you as the current user, the Import Relationships and Create Equivalent Relationships actions are disabled.

The Data Management: Lineage role should be assigned to any user who needs access to the SAS Lineage application but who is not permitted to update any relationship data. These users cannot import relationships. The Lineage: Administration should be assigned to any user who needs full access to the SAS Lineage application. This full access includes the ability to import relationship via the SAS Lineage user interface.

**Define Users and Link Them to Groups (and Roles)**

SAS Lineage is installed as part of a bundle of products. After installation, an administrator uses SAS Management Console to perform the following tasks:

- Create a user definition for each person who uses SAS Lineage.
- Create any custom groups (and roles) that you might require if the default groups provided by SAS Lineage do not meet your needs.
- Assign each user to one or more of the default or custom groups in order to grant each user the capabilities that he or she requires.

For more information about defining users and groups in SAS Management Console, see *SAS Management Console: Guide to Users and Permissions*.

**Usage Notes for Roles and Capabilities**

Capabilities cannot grant privileges in excess of those that are granted by other, relevant systems. For example, suppose that you have the capability called UpdateRelationships. This capability alone is not sufficient to update relationships in another application. To do that, you (or a group to which you belong) must be a member of an appropriate group for that application.
Connecting SAS Lineage to Applications

You must supply the information needed to connect the applications that use SAS Lineage to SAS Lineage itself. Consult the documentation for those applications for more information.

**Note:** The SAS Relationship Content Service must be loaded automatically. The automatic relationship loading option is off by default. For more information about configuring automatic loading, see the "Configuring Automatic Relationship Loading" topic in the *SAS Intelligence Platform: System Administration Guide*. This book is available from the following page: [http://support.sas.com/documentation/onlinedoc/intellplatform/tabs/admin94.html](http://support.sas.com/documentation/onlinedoc/intellplatform/tabs/admin94.html).
Accessing SAS Lineage

Accessing SAS Lineage

Overview .............................................................................................................................. 7
Use a Standard URL ............................................................................................................. 8
Connect from Another Application ....................................................................................... 9
Connect from SAS Data Management Console ................................................................. 9

Adding Links to the SAS Data Management Console Home Page ..................................... 11

Accessing SAS Lineage

Overview

You can access SAS Lineage in the following ways:

- “Use a Standard URL” on page 8
- “Connect from Another Application” on page 9
- “Connect from SAS Data Management Console” on page 9
Use a Standard URL

You might have been given a standard URL to use to log on to SAS Lineage. This lineage URL follows this pattern: http://hostname/SASLineage. However, the administrator can change the URL during installation.

To access SAS Lineage using a standard URL:

1. Click the URL that is supplied by your system administrator, or paste it into the address field of your browser.

   The Sign In window for SAS web applications is shown in the following display:

   ![Sign In to SAS](image)

2. Enter your user ID and password in the appropriate fields.

   **Note:** Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the web application server. If you need assistance, contact your system administrator.

3. Click **Sign In** to access the SAS Lineage in a browser window.

4. To sign off, click **Sign Off** in the upper right corner of the window. If you are prompted about unsaved changes, click **Sign Off** to exit without saving, or click **Continue** to keep working.
Connect from Another Application

SAS Lineage can be accessed from buttons and links that you can find in SAS database management applications, SAS business intelligence applications, and related third-party applications. If you have already logged on to one of the SAS applications, you will be taken directly to SAS Lineage. If you have not logged on to a SAS application, you will see the Sign In window explained in “Use a Standard URL” on page 8. Follow the same steps to log on to SAS Lineage.

Connect from SAS Data Management Console

Another way to access SAS Lineage is to use the standard sign-in window to access the SAS Data Management Console home page. Then you can click the link in the Links section to access the SAS Lineage window. If a link to SAS Lineage is not displayed in the Links section, ask your administrator to following the instructions in “Adding Links to the SAS Data Management Console Home Page” on page 11.

The port for all SAS Data Management web components is configured during installation. The default port number is 80. If your site is using the default port for these web components, you can access SAS Data Management Console from the following URL: http://hostname/SASDataManagement.

To log on to SAS Data Management Console:

1. Click the URL that is supplied by your system administrator, or paste it into the address field of your browser to display the SAS log on window.
The window is shown in the following display:

**Figure 2.1 Log On Window for SAS Data Management Console**

2 In the **User ID** field, enter your user ID.

3 In the **Password** field, enter the password for your user ID.

   **Note:** Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the web application server. If you need assistance, contact your system administrator.

4 Click **Log On** to display the home page for SAS Data Management Console.
Adding Links to the SAS Data Management Console Home Page

An administrator can use SAS Management Console to define a web link to SAS Lineage on the SAS Data Management Console home page. The links appear under a Links heading on the home page.

To add the link:

1. Log on to SAS Management Console as an administrator.

2. Expand the following folders on the Plugins tab: Application Management ➔ Configuration Manager ➔ Data Management Cnsle 2.1 Home Page.

3. Right-click Data Management Cnsle 2.1 Home Page and select Properties.

4. Click the Settings tab.

5. Select Home Page Settings in the panel at left.

6. Use the Home Page Settings panel to add the URL for the desired web page.

7. Click OK to save your changes.

8. Restart the SAS Web Application Server in order for the new URL to show up on the home page for SAS Data Management Console.
Chapter 2 / Accessing SAS Lineage
Understanding the Interface

SAS Lineage Window

Overview

The SAS Lineage window consists of the following components:

- “Diagram Pane” on page 14
- “Details Tab and Filter Tab” on page 17

The Details and Filter tabs are displayed when you select an item in a diagram and click Details.
Diagram Pane

The following display shows a sample Diagram pane:

Figure 3.1  Sample All Relationships Diagram Pane

The Diagram pane displays the diagram for the object that you selected in the Select a Lineage Subject window. The pane will be empty if you closed the Select a Lineage Subject window without selecting a subject. See “Selecting a Subject” on page 21.
The pane shows the selected subject in the default view. For information about changing the default view, see “Manage User-Defined Views” on page 38.

Due to how relationships work, diagrams can include duplicate objects, such as the same job, as a source and a target. These duplicate objects are displayed in only the Impact Analysis and Governance diagrams. They are not displayed in All Relationships diagrams.

An example of a diagram that displays duplicates is a transformation that can both read from and write to the same table. Objects representing the table appear both upstream from the transformation node and downstream from the transformation node in the diagram.

The following display shows duplicate objects in a diagram:

**Figure 3.2  Duplicate Items in a Diagram**

The duplicate objects are identified by an icon in the lower right corner of the node. The only special action associated with duplicate objects is that selecting one of the duplicate objects in the diagram causes its matching node to be also selected.

Objects can also be clustered in the diagram. Objects are clustered based on their types, relationship to the expanded object, and direction of that relationship. If enough objects of the same type are related to the expanded object with the same relationship type and relationship direction, these objects are clustered together as one node in the diagram.
The following diagram shows a partially expanded cluster of objects in diagram:

**Figure 3.3  Clustered Objects in a Diagram**

When a clustered object is expanded, it displays all of the relationships that its member objects are a part of, except relationships between member objects. Expanding a clustered object is similar to having expanded each member object individually. Once a clustered object has been expanded, when any of its members are unclustered, those objects should be added to the diagram in a fully expanded state. If a clustered object has not been expanded, any member objects that are added to the diagram are displayed in a collapsed state, unless all of the objects to which that member object is related are already present on the diagram.

The toolbar at the top of the window is shown in the following display:

**Figure 3.4  Toolbar**
You can use the components in the toolbar to perform the following functions:

- Access the **Action** button. The **Action** button duplicates many of the toolbar functions and adds the following functions: search for a subject, manage and edit views, expand and collapse diagrams, print diagrams, and import sets of relationships.

- Select the view used in the diagram.

- Select an object and open the pane that contains the **Details** and **Filters** tabs.

- Display a diagram for a selected item in a new tab. This diagram uses the current view.

- Resize the diagram.

- Reset the zoom level.

- Refresh the screen to display the original diagram.

The legend bar, which shows the types of connections between objects, is located at the bottom of the screen and shown in following display:

*Figure 3.5  Legend Bar*

```
Legend:   Is associated with   Is parent of   Is equal to   Is dependent on   Contains   Is synonymous with
```

**Details Tab and Filter Tab**

The pane that contains the **Details** tab and the **Filter** tab are displayed when you select an object in a diagram and click **Details**.
The **Details** tab is shown in the following display:

*Figure 3.6*  *Details Tab*
The **Filter** tab is shown in the following display:

*Figure 3.7  Filter Tab*

You can create filter conditions and apply them to the current diagram. You can use the **Action** button to save the filter conditions as a view and add it to **View** menu. For more information about filters, see “Create a User-Defined View” on page 35.
Preferences Window

You can click **Preferences** in the **File** menu to specify user locale, theme, and display preferences for SAS Lineage.
Selecting a Subject

You can use the Select a Lineage Subject window in SAS Lineage to search for the subject of a SAS Lineage diagram. In addition, you can filter the search by type. This window is displayed when you log on to SAS Lineage. Note that you click Cancel to access an empty SAS Lineage window.
To select a subject:

1. Open SAS Lineage to access the Select a Lineage Subject window.

2. If you want to select from all of the available subjects, leave **Search** blank and set **Type** to **All Types**.
   
   This all-inclusive selection is shown in the following display:

   **Figure 4.1 Select from All Subjects**

3. Click **Apply filter** (the check icon) to run the search.
The following display shows the listing generated by the search:

**Figure 4.2  All Subjects Listing**

4 You can also limit the scope of your selection. For example, you can enter *Load* into *Search* and leave *Type* unchanged.
The following display shows the listing from the more restricted search:

**Figure 4.3  Restricted Search Listing**

You can open the drop-down menu in **Types** to review and select the types that you want to filter on in your search. When you select the **Open subject in new tab** check box, the diagram generated for the selected subject is opened in a new tab in SAS Lineage. When the tab is not selected, the diagram generated for the selected subject replaces the diagram for the currently active subject.
The available types are shown in the following display:

*Figure 4.4  Available Types*

---

### Choosing a View

#### Overview

Once you have selected a subject of a SAS Lineage diagram, you can choose a view. SAS Lineage is shipped with the following default views:
All three of these views are based on information included in the Relationship database that is a part of the Web Infrastructure Platform Data Server. The All Relationships view displays all the relationships in the Relationship database for a selected subject item in a network diagram. The Governance and Impact Analysis views are left-to-right dependency views. These diagrams display a subject item and all its related items in a left-to-right dependency view. Items to the left of the subject are considered predecessor or upstream. Items to the right of the subject are considered successor or downstream. All relationships in the diagram have a direction and all items related to the subject are placed either upstream or downstream based on that direction. These views also have grouping capabilities, so that included items appear inside a group node that represents the parent item.

The Governance and Impact Analysis views do not support displaying equivalent nodes for nodes that are also group nodes. For example, you could have a Job1 that includes 3 tables and a Job2 that includes 2 tables. If you create an equivalent relationship between Job1 and Job2, that equivalent relationship will not show up in Governance and Impact Analysis views. Equivalent objects that are not group nodes are displayed in Governance and Impact Analysis views. All equivalent objects are displayed in All Relationships views.

Governance helps organizations maintain a single, consistent set of policies and processes for developing, monitoring and managing corporate data. The Governance view shows you the data that you need to use capabilities such as data profiling, data integration, common language creation, and hierarchy management.
The following display shows the Governance view of the *Loading Dock* term:

**Figure 4.5  Governance View of a SAS Business Data Network Term**

The Impact Analysis view includes SAS Business Data Network terms, but it does not include the *is associated with* relationship to the terms. Impact analysis identifies the tables, columns, jobs, and transformations that are affected by a change to a selected table or column. Use impact analysis before changing or deleting a metadata object to see how that change can affect other objects.

The following display shows the Impact Analysis view of the *Loading Dock* term:

**Figure 4.6  Impact Analysis View of a SAS Business Data Network Term**

This diagram displays the hierarchy of the *Loading Dock* term and its parent terms.

All of the views handle related items in the same way. When an item has related items, an **Expand** button (+) is available on that item. Click the **Expand** button to display that item's related items. This process is repeated for each item displayed. The subject item in an All Relationships view initially does not have an **Expand** button because it is always expanded when the diagram is brought up.

You can also create and save custom user-defined views. However, these views cannot be shared with other users. See “Creating and Managing User-Defined Views” on page 35 for information about user-defined views.
All Relationships

The following display shows the All Relationships view for a *Loading Dock* item.

*Figure 4.7  All Relationships View*

You can drill down into the view to see more detail or filter it by item type or relationship to remove items that you do not need to consider.

The following display shows the All Relationships diagram in a drilled-down view:

*Figure 4.8  All Relationships Drill-Down View*
Governance

The following display shows an unexpanded Governance view of a job:

Figure 4.9  Unexpanded Governance View

An expanded Governance view is shown in the following display:

Figure 4.10  Expanded Governance View

You can expand the view to see upstream and downstream items. Click the arrow icon on a table object to see the columns, as in the preceding IFTENCARS and CARS_HIVE tables.
You can also hold the mouse pointer over any item in any diagram to see more details, as shown in the following display:

**Figure 4.11  Item Detail Window**

![Item Detail Window](image)

**Impact Analysis**

The following display shows an unexpanded Impact Analysis view of a job:

**Figure 4.12  Unexpanded Impact Analysis View**

![Unexpanded Impact Analysis View](image)

An expanded Impact Analysis view is shown in the following display:

**Figure 4.13  Expanded Impact Analysis View**

![Expanded Impact Analysis View](image)
Note that the Governance and Impact Analysis views for the *Load data into Hive* job appear to be identical.

The Impact Analysis view also displays the following filter for the view:

**Figure 4.14  Impact Analysis View Filter**

![Filter: Relationship types: ‘Is parent of, Is equal to, Is dependent on, Contains, Is synonymous with’](image)

---

**Using a Network Diagram**

You can generate a network diagram by running a view that specifies **Network Diagram** in the **Display type** field. You can access this setting in the properties window for the view.

The following display shows a network diagram generated by the All Relationships view for the 1b. Write to HDFS job:

**Figure 4.15  Network Diagram**

![Network Diagram](image)

The job is displayed in an unexpanded cluster. The job object that was selected as the subject of the view is highlighted in a color that contrasts with the other objects.
You can click the **Expand** controls on the branches of the cluster to see the expanded view that is shown in the following display:

*Figure 4.16  Expanded Network Diagram*

Click **Expand** on additional objects to drill down further. You can move the mouse pointer over any object to view a description of the object and the object type.

You can also select an object in the diagram, such as one of the Transfer to Hadoop objects to designate as the subject for a new diagram.
This refocused diagram is displayed in a new tab, as shown in the following display:

*Figure 4.17  Refocused Network Diagram*

![Refocused Network Diagram](image)

Note that the new subject of the diagram is highlighted this time. However, the original subject is treated as just another object in the diagram.

**Using an Impact Diagram**

You can generate an impact diagram by running a view that specifies *Network Diagram* in the *Display type* field. You can access this setting in the properties window for the view.
The following display shows an impact diagram generated by the Impact Analysis view for the 1b. Write to HDFS job:

**Figure 4.18  Folded Impact Diagram**

Parent objects in Impact diagrams have two states, folded and unfolded, that take advantage of grouping capabilities. The diagrams also support an *include* relationship. When a diagram is folded, the included items are displayed inside a group node that represents the parent item. In this case, the two Transfer to Hadoop objects are included inside the 1b. Write to HDFS object. You can unfold the diagram by clicking the *Expand* controls on the left and right side of the group object. This action displays the upstream and downstream objects in the diagram. Upstream objects come before the diagram subject, and downstream objects come after the subject.

**Figure 4.19  Unfolded Impact Diagram**

You can also select an object in the diagram, such as the As You Like It object, to designate as the subject for a new diagram. You can move the mouse pointer over any object to view a description of the object and the object type.
This refocused and unfolded diagram is displayed in a new tab, as shown in the following display:

*Figure 4.20  Refocused and Unfolded Impact Diagram*

---

**Creating and Managing User-Defined Views**

**Overview**

- “Create a User-Defined View” on page 35
- “Manage User-Defined Views” on page 38

**Create a User-Defined View**

You can use the New View window to create a user-defined view. You can save these views, which adds them to the drop-down list in the **View** field. Then you can apply them to the current SAS Lineage diagram. User-defined views are available only to the user who created them.
To create a user-defined view:

1. Click **New View** to access the New View window. You can also save the settings in the **Filters** tab in the Details pane as a view.

2. Enter a name for the view, such as **BDN term\BDN tag**, in the **View name** field.

3. Specify a display type for the view, such as **Impact Diagram**.

4. Select the relationship types for the view filter. The **BDN term\BDN tag** view uses **All Relationship Types**.

5. Select the object types for the view filter. This view uses the **TAG.BDN** and **Term.BDN** types. Note that you can also specify the behavior for deselected items for both relationship types and object types.

6. Click **OK** to save the view and add it to the drop-down list in the **View** field.
The following display shows the completed New View window for the *BDN term* tag user-defined view:

*Figure 4.21  User-Defined View Definition*
Note the presence of the *etldemo* user in a portion of the Governance view of the SAS Business Data Network term Social Media in the following display:

*Figure 4.22  Governance View*

The user object type is not included in the *BDN term*\*BDN tag* user-defined view, so it should not be present when the view is applied to the diagram for the term.

The following display shows the partial diagram for the same SAS Business Data Network term after the *BDN term*\*BDN tag* user-defined view has been applied:

*Figure 4.23  User-Defined View*

Note that the diagram contains three SAS Business Data Network terms (*Consumer Banking*, *Customer*, and *Profiles*) and a tag (*Banking _BDN_SAS SA*), but it does not contain a user.

**Manage User-Defined Views**

You can access the Manage Views window by clicking the **Action** button and opening the **View** submenu.
This path is shown in the following display:

*Figure 4.24 Views Submenu*
Then, click **Manage Views** to display the following window:

**Figure 4.25  Manage Views Window**

You can use the items in the toolbar to perform the following functions:

- create a new view
- edit the properties of a selected view
- set a selected view as the default view
- move a selected view up or down in the list
- copy the settings from a selected view into a new view
- delete a selected view
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore
for additional books and resources.

SAS
THE POWER TO KNOW®